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File Menu

The File menu commands operate on collections of macros called Macro Archives.    A Macro Archive is a file 
containing one or more recorded macros. 

New Archive Creates a new macro archive.

Open Archive Opens an existing macro archive.

Close Archive Closes an opened macro archive.

Save Archive Saves an opened macro archive using the same file name.

Save Archive As Saves an opened macro archive to a specified file name.

Recent Archives Displays a list of recently opened archives.

Exit Exits WinMacro.

See Also:

Keyboard Shortcuts



Macro Menu

The macro menu commands allow you to work with individual macros.

Record Begins a macro recording session.

Play Plays a recorded macro.

Save As Invokes the save macro as dialog.

Delete Removes a macro from an archive.

Edit Invokes your favorite Winbatch Script editor.

Stop Ends a macro recording session.

Advanced Options Invokes the advanced options dialog.

See Also:

Keyboard Shortcuts



Help Menu

The Help menu offers the following commands to assist you with this application:

Help Contents Offers you an index to topics on which you can get help.

About WinMacro Displays Winmacro’s version number.



WinMacro's Main Window

The main window provides you easy access to macro record and playback functionality: 

Element Action
Record Keystrokes When checked, keystrokes are included in your macro.

Record Mouse Moves When checked, mouse activity is included in your macro.

Advanced Record Options Displays the Advanced Options dialog.

Macro List Displays the name of each macro stored in the currently open 
Macro Archive.    If a macro has a hotkey, it is displayed to the left of 
the macro’s name.

Done Ends this WinMacro session.    Any open Macro Archive is 
compressed and closed. 

Quit Ends this WinMacro session. Any open Macro Archive is closed.

Tool Bar The toolbar buttons provide shortcuts to Macro menu commands.



Advanced Record Options Dialog

The Advanced Record Options Dialog is displayed by selecting the Advanced Options button or menu command.    
This dialog allows you to give your macro additional features before you begin to record.

The dialog can also be used to view the option set for a recorded macro.    The Playback Speed and Hotkey options 
can be changed both before and after recording. 

Element Action
Macro Activates the Window When checked, the window you specified in the Window 

Name edit box is the active window at macro startup.

Record Mouse Moves Relative 
to Window

When checked, the window you specified in the Window 
Name edit box is the mouse movement origin for your 
macro.

Window Name Holds the name of the Window that will be activated at 
macro startup and/or be the mouse movement origin for 
your macro.

Play Macro When Hotkeys 
Pressed

Check to indicate that a hotkey is associated with the 
macro.

Hotkey Combination Holds the key sequence that plays your macro. 

Play at Record Speed When checked, macro playback events will occur at about 
the same pace as they were recorded.

Play Speed Shrinks or stretches the time it takes to playback the 
macro. 

Have the Macro Launch an 
Application

When checked, the application you specified in the 
Application Name edit box will be started by the macro. 

Application Name Holds the name of the application you wish your macro to 
start. 

Browse Invokes a file dialog to assist you in finding the name and 
path of the application to be launched. 

Application Parameters Holds any startup command line parameters the 



application to be launched may need. 



Macro Save Options Dialog

The Macro Save Options dialog allows you to convert your recorded macro to a WinBatch Script and also make your 
macro available for playback anytime by adding it to PopMenu's global menu file.    This dialog is displayed by clicking 
the Save As button on the main window toolbar or selecting the Save As menu item form the Macro Menu
.

You must select a macro from the Macro List before you can launch this dialog.

Element Action
Save As WinBatch 
Script

When checked, a WinBatch script version of your recorded 
macro is created.

Save In Holds the location your macro's WinBatch script will be 
placed in. 

Browse Launches a folder dialog to assist you selecting a folder for 
your macro's WinBatch script version.

Optimization Sets the number of WIL mouse movement function calls 
WinMacro includes when converting your macro to a 
WinBatch script.

Add the Macro to 
PopMenu

When checked, your is macro added to PopMenu's main 
menu. 

Macro Name Holds the name of your recorded macro.



New Archive

Opens a new Macro Archive.    The archive is given a unique default name that appears on WinMacro's title bar.    You 
can change the name of the new archive and the folder for it by clicking the Save Archive As menu option. 

Short Cut
Keys: Ctl + N



Open Archive

Invokes the Archive Open dialog, which allows you to select a folder and Macro Archive file to open.    You can add, 
change and remove macros for an open Archive.

Only one Archive can be open at a time, so a currently open Archive will be closed for you. You may be asked to give 
a name to and select a folder for the open archive before it is closed. 

Short Cut
Keys: Ctl + O

 



Close Archive

Closes the currently open archive. You may not record or play a macro until you have an Archive open.

Note: WinMacro will automatically close any open archive when you open an existing or new archive, or end your 
WinMacro session.



Save Archive

Saves changes to the currently open archive to permanent storage.    The archive is open and ready to go after the 
save operation is complete.

Short Cut
Keys: Ctl+S

Note: WinMacro attempts to remove any unused space from your archive during the save operation.    Depending on 
your system's performance and the size of the archive, this process may take a few moments.



Save Archive As

Invokes the Save Archive As dialog. You can use this dialog change the name of your archive.    You can also select a 
new folder for the archive. 

It is a good idea to give your archive a content suggesting name but it is important to remember that PopMenu menus 
rely on the archive name and location to find and play macros.    If you change the macro archive name or location, 
you will need to update PopMenu's menu file for each macro in the archive that is saved as a PopMenu menu item. 

See Also:

Running Macros from PopMenu



Recent Archives

Displays a popup list of recently opened archives.    Click on an archive name to open it.



Exit

Ends this WinMacro session.    This command is the same as selecting the Close command from the System menu or 
clicking the Done button on WinMacro's main window.



Record

Starts recording a macro.    During macro recording, keystrokes and/or mouse activities are saved to the current 
Macro Archive.    Note that WinMacro cannot record keystrokes sent to a DOS window.

You can select the type of activity to record by checking or clearing the Record Key Strokes and Record Mouse 
Moves check boxes on WinMacro's Main Window before selecting this menu item.    You can set more macro 
attributes by clicking the Advanced Options button on the main window before you start recording. 

You end macro recording by either clicking the Stop button on WinMacro's Tool Bar selecting the Stop Macro Menu 
item or pressing the Stop hotkey.

Short Cuts
Keys: Alt + Ctl + Insert

Toolbar:

See Also:

Advanced Record Options Dialog
Keyboard Shortcuts



Play

Starts macro playback. During playback WinMacro repeats the keystrokes and/or mouse activities you recorded in 
the selected macro. 

You select a macro for playback by clicking the macro's name in the Macro List on WinMacro's Main Window.    You 
will notice that the play Macro Menu
 item and the play toolbar button are disabled until you make a selection. 

Macro playback can be interrupted at any time by pressing the    Stop hotkey.

Short Cuts
Keys: Alt + Ctl + Home or

Press the hot key combination associated with the macro.

Toolbar:

See Also:

Advanced Record Options Dialog
Add the Macro to PopMenu
Hotkey Combination



Save As

Invokes the Macro Save Options dialog.    Using this dialog you can save the selected macro as a WinBatch script 
and as a PopMenu menu item. Save As also allows you to change the name of your macro.

You select the macro you wish to save by clicking the macro's name in the Macro List on WinMacro's Main Window.    
You will notice that the save as menu item and the save as toolbar button are disabled until you make a selection.

Short Cuts
Toolbar:

See Also:

Add macros to PopMenu menus
Turn a macro into a WinBatch script



Delete

Removes the selected macro from the currently open archive.    Use this item with caution.    Once a macro is deleted 
from an archive it is gone forever.

You select the macro you wish to delete by clicking the macro's name in the Macro List on WinMacro's Main Window. 
You will notice that the Delete menu item and the Delete toolbar button are disabled until you make a selection. 

Short Cuts
Toolbar:



Edit

Invokes your favorite editor on the WinBatch script version of the selected macro.

You select the macro you wish to edit by clicking the macro's name in the Macro List on WinMacro's Main Window.    
You will notice that the edit menu item and the edit toolbar button are disabled until you make a selection.      The 
menu item and button will also be disabled, if you have not saved the selected macro as a WinBatch script.

WinMacro invokes the editor used by PopMenu when you select edit menu files menu items on PopMenu's global 
menu. You can use a different editor by changing the Editor value in the PopMenu section of the PopMenu.ini. file 
This file is normally found in the WinBatch system directory

Short Cuts
Toolbar:

See Also:

Macro Save Options
Turn a macro into a WinBatch script



Stop

Terminates macro recording. When you have performed all the keystrokes and mouse activities you wish to include in 
you macro, click this menu item. 

There are several additional key stroke combinations that stop macro recording and playback. They include: 
alt+ctl+delete, the "Windows" key and the ctl+break combination.

Short Cuts
Hotkey: Alt + Ctl + End

Toolbar:

See Also:

Record



Rename

If you choose to rename your macro, simply right click on your macro's existing name, and then type in the new name 
of your choice.



Advanced Options

Invokes the Advanced Record Options Dialog.    Use this dialog to set and view macro attributes. To set options 
before you record make sure that no macro name is selected in the Macro List of WinMacro's Main Window.    After a 
macro has been recorded, only the hotkey and playback speed can be changed.

View a recorded macro’s setting or change its hotkey or playback speed by click Advanced Options while the macro’s 
name is selected in the Macro List

See Also:

Record



Help Contents

Displays the WinMacro help contents. Use this menu item to display the opening screen of Help.    From the opening 
screen, you can jump to step-by-step instructions for using WinMacro and various types of reference information. 

Once you open Help, you can click the Contents button whenever you want to return to the opening screen.



About WinMacro

WinMacro version 1.0
(Prdeck Version: 01.00.00c)

Copyright © 2001

Wilson WindowWare, Inc.

Contact Wilson WindowWare at:

http://www.Winbatch.com

TechSupport:    (206) 937 - 9335



Record Keystrokes

Check this box to include keystrokes in your macro. 

If a macro name is selected in the Macro list, the check box indicates its state when the macro was recorded.

NOTE:      Some "system" key strokes cannot be recorded by WinMacro, such as the "Alt+tab" key sequence.    Also, 
WinMacro will not record hotkeys you have assigned using WinMacro or hotkeys assigned using shortcuts or the start 
menu.

Also, WinMacro cannot record keystrokes sent to a DOS window.



Record Mouse Moves

Check this box to include mouse movements and button clicks in your macro.

If a macro name is selected in the Macro List, the check box indicates its state when the macro was recorded.



Macro List

Displays the name of each macro stored in the currently open Macro Archive.    If a macro has an assigned hotkey 
combination, it is displayed to the right of the macro's name.

Select a macro name from the list by left clicking it. Once a macro is selected you can view and modify settings, play 
the macro, and edit its WinBatch script version by simply clicking toolbar buttons. 

Right click a macro name to display the Macro popup menu. Clicking a menu command will perform the associated 
action on the selected macro.



Done

Use this button to end a WinMacro session.    If a Macro Archive is open, unused space is removed and the file is 
closed.    You can also use the System menu's Close command or the File menu Exit command to produce the same 
result.



Quit

Use this button to immediately end a WinMacro session.    WinMacro does not attempt to remove unused space 
before closing an open archive file.



Tool Bar

The toolbar is displayed across the top of the application window, below the menu bar. The toolbar buttons provide 
quick access to Macro menu commands.

Click To

Begin a macro recording session.

Invoke the save macro as dialog.

Removes a macro from the an open archive.

Invoke your favorite Winbatch Script editor.

End a macro recording session.



Activate Window

Check this box to have your macro activated a window at startup.    An activated window is visible and receives the 
keyboard input. 

Use the option when you are going to record keystrokes and you want to be sure a particular window receives them 
when the macro begins to play. 

If you check this box, you will need to enter the window title in the Window Name edit box.
The window you specify in the Window Name box must be on the Windows Desktop (it can be iconic) when you start 
recording or playing your macro.

Note: This option cannot be changed for a macro after the macro is recorded.



Record Relative to Window

Check this box to have all mouse movements recorded relative to the upper left hand corner of the window you 
specify in the Window Name edit box. 

Use the option when your macro will manipulate a window's menus and controls, and the window may appear in 
different places of the desktop on successive runs. 

The window you specify in the Window Name box must be on the Windows Desktop (it can be in icon form) when you 
start recording or playing your macro.

Note: This option cannot be changed for a macro after the macro is recorded.



Window Name

Type in the name of the window that will be activated at macro startup and/or be the mouse movement origin for your 
macro. A window's name appears in the bar at the top of a window. 

Precede the text with a tilde (~) to indicate you are entering a partial name.    Your macro will then use the first window 
who's name contains the text typed into the edit box (minus the '~', of course). 

Placing a tilde after the last character will cause your macro to look for a window whose name ends with the typed in 
partial name (again, minus the '~').

You must check either the Activate Window or Record Relative to Window check box to enable this dialog element. 

Note: This option cannot be changed for a macro after the macro is recorded.



Play Macro When Hotkeys Pressed

Check this box to indicate you wish to associate a hotkey with the macro. Hotkeys allow you to easily run your macro 
by pressing the key combination you select.

Select the keep combination by moving to the Hotkey Combination box and press the keys of your choice. View the 
help information for the Hotkey Combination box for details.

Note: This option can be changed for a macro after the macro is recorded.



Hotkey Combination

The key sequences you type in this box will playback your macro. Use some combination of the Alt, Ctrl, and Shift 
keys with a letter key, a number key, an “F” key or an editing key.

If the key combination is not already in use, the keys you typed will appear in the box separated by plus (+) signs.    If 
the key combination is already in use , “none” will appear in the Hotkey Combination box.    When this occurs, simply 
try another combination.

You must check the Play Macro When Hotkeys Pressed check box to enable this dialog element. 

Note: This option can be changed for a macro after the macro is recorded



Play at Record Speed

Check this box to have your macro playback keystrokes and/or mouse activity at the speed you performed them while 
recording. 

Uncheck the box to activate the Play Speed Slider and change the playback speed.

 Note: This option can be changed for a macro after the macro is recorded.



Play Speed

Move the slider's arrow to the left or right to change macro playback speed.    If you move the arrow to the left the 
mouse cursor will move more slowly across the screen and keys will be typed at a slower rate.    Moving the arrow to 
the right has the opposite effect. 

When the arrow is set all the way to the right, the mouse cursor may move so quickly that it temporarily disappears.

Note: This option can be changed for a macro after the macro is recorded.



Launch Application

Check this box to have your macro start another application when it starts.    The application will be started when you 
begin to record and at the beginning of each subsequent playback.

If you check this box, you will need to place then name of an application in the Application Name edit box. 

Note: This option cannot be changed for a macro after the macro is recorded.



Application Name

Type in the name of the application you wish the macro to start. 

If the application is not located in the current folder, the Windows system folders or in a folder listed in the PATH 
environment variable, you will need to include the application's location with the name.    If you are unsure of the path, 
click the Browse button to start the Application Location dialog.

The application will be started by the macro before any keystrokes or mouse activities are recorded or played.

You must check the Launch Application check box to enable this edit box. 

Note: This option cannot be changed for a macro after the macro is recorded.



Browse

Invokes the Application Name dialog to assist you in finding the name and location of the application your macro will 
launch.    The name and location you select are automatically placed in the Application Name edit box.

You must check the Launch Application check box to enable this button. 



Application Parameters

Type any startup command line parameters your application may need. This information is optional and based on the 
requirements of the application your macro will launch.

You must check the Launch Application check box to enable this edit box. 

Note: This option cannot be changed for a macro after the macro is recorded.



Save As WinBatch Script

Check this box to create a WinBatch script version of your recorded macro.    This plain text version of your macro 
can be modified with the editor of you choice.    Simply click the Edit button on the WinMacro toolbar to view and 
modify the script.

The script version of your macro is just like any other WinBatch script. You can use the full suite of WIL functions and 
control structures to enhance your scripts. See WinBatch documentation for more information about the WIL 
programming language.

The file containing the script version of your macro is given the same name as the macro and has the “.wbt” 
extension.

It is important to remember that the macro stored in the Macro Archive file is not changed when you edit the script 
version of your macro. If you do modify your script, it is a good idea to give the modified version a new name.    This 
reduces the chance of WinMacro overwriting your modified script. As well, WinMacro does not automatically update 
your WinBatch script if you re-record your macro.    You will need to invoke the Save As dialog and check the 
appropriate box in order to update the plain text version



Save In

Type in a location for your macro's script version. Do not include a name for your script.    The script file will 
automatically get the same name as the macro you are converting.

If you are unsure of the path, click the Browse button to start the Folder Finder dialog.

You must check the Save As WinBatch Script check box to enable this edit box. 



Browse

Invokes the Folder Finder dialog to assist you selecting a folder for your macro's WinBatch script version.    The 
location you select is automatically placed in the Save In edit box.

You must check the Save As WinBatch Script check box to enable this button. 



Optimization

Move the slider up or down to tell WinMacro the amount of mouse movement detail to put in your script.    Detail can 
make the script much longer. 

If you are only interested in mouse button clicks and drag 'n drop operations, you can probably move the slider arrow 
to the bottom position.    WinMacro will never optimize these actions out of the script.

If, however, you are interested having your script move the mouse in a more natural way, move the arrow up for more 
detail.    It may also be necessary to include more detail, if your macro accesses any screen objects without using 
button clicks or keystrokes. For example, if your macro accesses a popup menu by holding the mouse over a 
dropdown menu item, it may be necessary to include more detail.

If you are not sure, experiment with several different settings. 

You must check the Save As WinBatch Script check box to enable this slider. 



Add the Macro to PopMenu

Check this box to add you macro to PopMenu's main menu.    WinMacro will create a new PopMenu menu item with 
the same name as your macro.    After you end your WinMacro session, simply double click PopMenu and then the 
new menu item to begin macro playback.

If your macro has a hotkey combination, you can start playback from the keyboard, too.

WinMacro places macros under the “Macros” submenu of PopMenu's global menu file. If WinMacro can not find the 
“Macros” submenu, it will add the macro to the end of the menu file.

If your macro is recorded with the either the Activate Window or Record Relative to Window options, PopMenu will 
only play the macro if it can find the associated window. 



Macro Name

Type in a name for your recorded macro.    It is highly recommended that you give your macro a descriptive name that 
will help you remember its function.

WinMacro will use this name as the name for the WinBatch script file and as the name of the PopMenu menu item.



Keyboard Shortcuts

Use the key combinations in the Hotkey column to invoke the command described in the Response column
  

Hotkey Response
Ctl + N Creates a new empty macro archive
Ctl + O Invokes the Open Archive dialog
Ctl + S Writes the open archive to disk

Atl + Ctl + Insert* Starts macro recording.
Alt + Ctl + Home* Starts playback of a selected macro.
Alt + Ctl + End* Ends macro recording or playback 

Ctl = Control key
Alt = Alt Key
'+' = press the listed keys at the same time. For example 'Ctl + N' means hold down the Control key and press the 
letter 'N' on your keyboard at the same time.

*If WinMacro finds that another application uses this key, it will attempt to assign a new key combination to the 
response.    You can check the key assignments by clicking the Macro menu on the menu bar of the main WinMacro 
window. 



Record a Macro

How To Record a New Macro:

1. Make sure a macro name is not selected in the Macro List on the main menu.

2. Check the Record Keystrokes box if you are going to be recording your keystrokes.

3. Check the Record Mouse Moves box if you are going to be recording your mouse movements.

4. Click the Advanced Options Button to set any advanced options you are interested in using. For example,    the 
option to Play your macro when hot keys are pressed.

5. Click the Record button and start your keystrokes and mouse moves. 



What is a Macro

A macro is a saved sequence of commands or keyboard strokes that can be
stored and then recalled with a single command or keyboard stroke.



Play a Macro

How to play a macro:

1. Select a macro for playback by clicking the macro's name in the 
Macro List on WinMacro's Main Window.

2. Press the Play button to playback your macro.



Turn a Macro into a WinBatch Script

How to turn a macro into a WinBatch Script:

1. Right click on the name of your saved macro file listed under the "Macro Name" item in Winmacro's main dialog 
box.

2. Select Save As.

3. Check the box entitled Save Macro as WinBatch Script.

4. Select the directory you would like to save your WinBatch script in. You may select a directory location by using 
the browse button.

5. You may change the name of your script by editing the current name of your macro given at the bottom of this 
dialog box.    When saving as a WinBatch script, Winmacro will automatically add on the ".WBT" file 
extension to the file name you specify.

6. This plain text version of your macro can be modified with the editor of you choice.



Playback a Macro with a Hotkey Combination

How to playback a macro with a Hotkey Combination:

1. Click on the Advanced Options Button button on WinMacro's main 
window. 

2. You will need to check the checkbox entitled Play Macro When Hotkeys Pressed to enable this dialog element.

3. To the right of this checkbox you may type your key sequences you will use to play back 
your macro.

4. You will need to use some combination of the Alt, Ctrl, and Shift keys with a letter key, a 
number key, an “F” key or an editing key.

5. If the key combination is not already in use, the keys you typed will appear in the box 
separated by plus (+) signs.    If the key combination is already in use , none will appear in the Hotkey 
Combination box.    When this occurs, simply try another combination.



Use Multiple Macro Archive files

You can use multiple archive files to group macros that have a related purpose. You can also use a separate archive 
file for macros that you plan to share with others. 

1. Start a new Macro archive by clicking New Archive in the file menu. 

2. Click on Save Archive to select a name and location for your archive.

3. Create your macros.

4. Click on Close Archive.    If you have not named your macro archive yet, 
you will be asked to do so when you close the file.



Add a Macro to PopMenu

How to add a Macro to PopMenu:

1. Right click on the name of your macro in the Macro List on the main 
menu.

2. Select Save As.

3. Check the box entitled Add the Macro to PopMenu's menu. This will 
add your macro to PopMenu's main menu.

4. WinMacro uses the macro's name as the PopMenu menu item title.    You can change the 
PopMenu item title by changing the macro name in the box at the bottom of the dialog.

5. Now after you finish this WinMacro session you will be able to to play your macro by 
clicking on its PopMenu menu item.

Warning: You can change the name of the PopMenu menu item by editing the global PopMenu file. However, 
WinMacro will not be able to find the menu item.    This may lead to WinMacro re-adding this menu item or being 
unable to remove it.



Why Use WinMacro?

By the power of automation, WinMacro can help you cut down on repetitious and time-wasting tasks.

Here are a few of WinMacro's many uses.

· Automating a dialup connection.

· Backing up files and zipping them up.

· Automating software installs.

· Launching programs.

· Inserting repetitive text into documents. For example, dates and contact information

· Script generation, allowing the user to get a running start at writing a WinBatch script.

 With a simple command or keyboard stroke, your macro can whiz through tedious tasks like these, giving you more 
time and less heartache.




